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Disclaimer 

In no event shall Kentec be liable for any damages or injury of any nature or kind, no matter how caused, that arise 
from the use of the equipment or software referred to in this guide. 

The information, figures, illustrations, tables, specifications, and schematics contained in this guide are believed to be 
correct and accurate as at the date of publication or revision. However, no representation or warranty with respect to 
such correctness or accuracy is given or implied and Kentec will not, under any circumstances, be liable to any 
person or corporation for any loss or damages incurred in connection with the use of this guide. 

The information, figures, illustrations, tables, specifications, and schematics contained in this guide are subject to 
change without notice. 

Unauthorised modifications to the software or its installation are not permitted, as these may give rise to 
unacceptable health and safety hazards. 

By installing this equipment on a computer network, the owner accepts full and unequivocal responsibility for 
ensuring that it is protected against all cyber threats and illegal tampering during the lifetime of the equipment. 

Any software forming part of this equipment should be used only for the purposes for which Kentec supplied it. The 
user shall undertake no changes, modifications, conversions, translations into another computer language, or copies 
(except for a necessary backup copy). 

In no event shall Kentec be liable for any equipment malfunction or damages whatsoever, including (without 
limitation) incidental, direct, indirect, special, and consequential damages, damages for loss of business profits, 
business interruption, loss of business information, or other pecuniary loss, resulting from any violation of the above 
prohibitions. 

 

Copyright 

Kentec, Ockular and Ockular 2D GUI are trademarks or registered trademarks of Kentec Electronics Ltd., 

Microsoft, MS and Windows are registered trademarks of Microsoft Corp. 

Other brand and product names mentioned in this guide may be trademarks or registered trademarks of their 
respective companies and are the sole property of their respective holders. 

 

Copyright © 2019 Kentec Electronics Limited 

 

All rights reserved. 
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1 Introduction 
The Ockular package is a powerful and sophisticated system providing graphical representation of your site on a PC. 
Ockular® gives building managers complete monitoring and control over fire detection providing a comprehensive fire 
risk and incident management system. This guide provides information on operating the Ockular system. 

This guide describes an Ockular system installed on MS Windows 7, but the Windows 8 and 10 installations are 
similar in operation. 

1.1 Guides in this series 
Document Description 

Ockular Installation and 
Cconfiguration Guide 

This guide contains details on installing and using Ockular hardware and 
software. It should be used in conjunction with appropriate 3rd-party 
documentation.  
This guide also shows how to configure and customize the Ockular system to 
reflect individual site, area or location plans. It should be used in conjunction 
with appropriate 3rd-party documentation and/or vendor logic. 

Ockular User Guide 
(This guide) 

This guide contains details about the day-to-day user operation of the Ockular 
system. 

Online and embedded Help Help will be available as PDF documents launched through the software Help 
button. 

1.2 Intended Audience for this guide 
This document is intended to be read by people responsible for the day-to-day operation of the Ockular 2D GUI. 
Some features and processes in this guide may not be available and are dependent on how the system has been set 
up and your permissible access level. 

1.3 How this guide should be used 
This guide should be read and fully understood before beginning any Ockular operational tasks. Thereafter it can be 
used as a reference document. 

This guide does not cover every aspect of Ockular operational use. Rather it shows the most intuitive methods, 
actions, cautions and shortcuts, while leaving the reader to explore other avenues once experience is gained.  

Note:  Some features and processes explained in this guide may not available due your access level 
permissions. 

Note: This guide is intended as a guide to using the Ockular 2D GUI software only. It is not intended to replace 
or supersede Site Operational Procedures (SOP) or any other document. 

1.4 How this guide is organised 
This guide is presented as dedicated chapters, sections and appendices, all of which are listed in a hyperlinked 
contents list in the preliminary pages. Sections and pages can also be accessed by using the pdf navigation tools, or 
you can use [Ctrl + F] to find specific words or terms. 
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2 Getting Started 
Your Workstation (or server) should already have the Ockular 2D GUI installed and it will need the licence dongle 
installed in a USB port before it can start. 

 

 

Ockular is designed to be permanently ‘on’, and should run full-screen by default. 

2.1 Starting the Ockular 2D GUI 
1. Make sure that the dongle is installed, then click the Ockular Icon: 

 
2. Log in with a valid Username and Password: 

 

 

 

 

 

 

 

Note:   Three incorrect tries will lock you out for 60 seconds. 

Note:   All login attempts (successful or failed) are time-stamped and recorded on the Event Log. 

 

 

 

 

 

 

 

  

CAUTION 
User logins are always logged and time-stamped, but do not automatically time-out. For system security and 
for your own protection you should always log out at the end of your session or when you leave the 
workstation. 

Never leave a logged in system unattended. 

Important: Do not 
remove License Dongle 
from the computer. 

Important: The Dongle 
is not a USB flash drive 
for saving files on. 
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2.2 The Home Screen 
Once logged in, all users will see their Ockular Home Screen. Below is an example of how this might look to a full-
access user: 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Fig. 1 Example Ockular Home Screen 

Note: The Configuration buttons will vary according to the user’s account authorisations, which is why it is 
important to log off to terminate your sessions. 

2.2.1 If the Home page is not as expected 
Ockular boots up using the last saved configuration but, if the screen is not as expected, authorised users can load 
an existing (or alternative) saved project or version. See the Ockular Installation and Configuration Guide for further 
details. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

CAUTION 

Changing the configuration settings may have global consequences for both the project and the users. 

Only trained and authorised personnel should change settings, and all significant changes should be briefed 
out to other users. 
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3 Ockular User Interface 
This section provides an overview of the Ockular operating mode. 

Note: The interface is highly editable, and therefore the items shown in Fig. 1 (above) may not all be apparent on 
your own project. 

The user interface utilises a familiar, Windows style layout, as shown below: 

 

 

 

 

 

 

 

 

 

 

Fig. 2 The Basic Interface Screen 

3.1.1 General Toolbar Menus 
The general toolbar menu and shortcut icons follow normal Windows protocols, and gives access to the following 
menus: 

 

Fig. 3 General Toolbar Menus and shortcut icons 

Menus Icons Description 

• File 

o Log Off 
o Change Password… 
o Exit 

• View 

o Show/Hide Main GUI [F5] 
o Show Home Position 
o Show 3D Controls (not available) 
o Show Page> 

 <Reflects the configuration settings button bar.> 

o Show Overlay> (not available) 
o Save Settings [Ctrl+S] 

• Tools 

o Alerts Volume 

• Help 

o User Manual 
o Quick Guide 
o Colour Key 
o About 

 Log Off 

 Toggles between the current Configuration 
GUI and the Home Screen 

 Show Home position 

 Launch Help  

 Colour Key 

 Search 

 

Table 1. Key to General Toolbar Menus and Icons  
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3.2 System Configuration Menu 
The left-hand side of the screen contains a user-sensitive System configuration menu that only shows the buttons 
granted by your log-on permissions.  

 

Fig. 4 System Configuration Menus for a full-access user 

3.2.1 Control Mode toolbar 
Control Mode has two buttons that toggle between the two modes shown below: 

 

 Puts the 2D GUI into Select Mode. Allows navigation of the GUI via menus, buttons, hotspots 
and macros. 

 

Puts the 2D GUI into Fire Coverage Mode and allows the user to filter the results by: 

• Detection Zones 

• Evacuation Zones 

• Operational Zones 

• Manual Evacuation 

3.2.2 Sidebar 
This editable / hideable menu is found on the left of the 2D GUI Main View screen, but the Home button and Level 
select buttons are hidden if a project only has one level. 

 This dialog shows the current page or screen. 

 
Home Button 
This button returns the user immediately to the pre-set Home view. 

Level select buttons. 
These user designated buttons allow quick access to the chosen level on the floor plan. 
Levels need not be confined to physical levels; a large floor plan may also be created to show a 
number of virtual or split levels. 

 
Edit Button 
Sited at the bottom of the screen, this icon toggles the UI between [Select] mode and [Editor] 
mode. 

 

  

Note: Depending on system 
setup, the following buttons 
may not be available for 
Operators: Account 
Management, Fire 
Configuration & Workstation 
Configuration. 
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3.2.3 Navigation Buttons 
Navigation buttons shown below can be created by the user, but are only operational when Ockular is in [Select] 
Mode. They are supplemental to the Sidebar, but generally have the same purpose. 

Normally these buttons would be created to open a Level image, e.g. a floor plan, but buttons could also be created 
to open a document or poster saved as an unassigned (i.e. not in the sidebar) image. E.g. you may want to show the 
emergency services a location photograph that can improve understanding of the 2D site plans or floor levels, or you 
may want to store and instantly view an image of the Standard Operating Procedures (SOP) relevant to specific alert 
types. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Fig. 5 Three examples of Optional Navigation Buttons 
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3.2.4 Macro Controls 
Project creators/editors have the option of creating and placing ‘on-screen’ customised macro controls, but 
operational users should be aware that controls can be hidden off-screen if the centre panel is too large for the 
available monitor space. 

 

 

 

 

 

 

Fig. 6 Optional Macro Controls 

3.2.5 Control Mode 
When opened, the Control Mode displays the last selected ‘level’, with slider bars if the image is too large to fit the 
screen. 

Note: Ockular project creators/editors should set the image size and default position when they create levels, but 
these settings can also be changed by authorized users. 

 

 

 

 

 

 

 

 

 

 

 

 

Fig. 7 Sample floor schematic showing call point and sensor placements 
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3.3 Zones 
Ockular supports different alert zones and zone types (see Table 2 below), which are displayed according to the 
current control mode. Right-clicking a zone displays a context menu that is defined by the current configuration. 

 

 

 

 

 

 

 

 

 

 

Fig. 8 Zone defined by irregular polygon 

Note: Large location plans may have to be scrolled to view zone and area extremities, or to access the [Home] 
button at the bottom of the image. 

The following behaviours apply to zones: 

Zone Type Control Mode Behaviour 

All Zones Any 

Hovering over a zone reveals its coverage (if zones have been 
created). 
Hovering over a symbol reveals its name, description, location 
and current status. 
Hovering over hotspots (if created) changes the pointer to a hand 
tool that, when left-clicked, will take you to the associated 
destination. 
Hotspots can be invisible, or they may have a visible boundary. 

Detection Zone 

Fire Mode 
Only the currently selected zone type will be displayed. 
Each zone is shaded according to its ‘Zone Status’. 
A normal zone has no shading. 

Evacuation Zone 

Operational Zone 

Table 2. Zone behaviours 
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3.3.1 Fire Zone Shading 
Typically, zones can be identified by these default zone shadings: 

Zone Type Shading Shading Type 

Normal state None None 

Fire state 
 

 Red 

Evacuation state 
 

 Blue 

Disablement 
state 

 

 Orange 

Test state 
 

 Yellow 

Selected state 
 

 Black stripes 

Coverage mode 
 

 Green 

Table 3. Fire Zone Shading 

Note: These shadings may have been customized to change the default colours and patterns, which could help 
users with accessibility requirements. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Fig. 9 Example of Zone shading 
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3.3.2 Alarm Flags 
Both Zones and Symbols display an alert flag generated by one or more external sources. The displayed flag is 
always the highest priority alert if several input sources send alerts. 

Alarm flags are allocated a higher priority than symbols and zones so they always appear on top of the display. 

Alarm flags may pulse on priority-state transitions. 

Note: Project creators/editors may have created custom alarm flags. 

The default alarm flags are: 

 
Unknown 

 
Information 

 
Warning  Reduced Service 

 Alarm  Priority Alarm 

 Critical 3 Alarm (Pre-Fire)  Critical 2 Alarm (Fire) 

 Critical 1 Alarm  Auxiliary Alarm 1 (Simulated Fire) 

 Auxiliary Alarm 2 Implicit Disablement)  Auxiliary Alarm 3 

 Auxiliary Alarm 4  Auxiliary Alarm 5 

 Auxiliary Alarm 6   

Table 4. Default Alarm Flags  
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3.3.3 Hotspots 
Hotspots are defined screen areas that, when clicked, jump you to their designated level. Hotspots are often used on 
the Home page to take you instantly to specific levels or sub-levels. 

Hotspot boundaries can be set to be visible or invisible, but the mouse cursor changes to a clickable hand cursor 
when it crosses the boundary (see image below). 

Hotspots can be created and edited only in Editor mode. 

Note: Unlike other items, Hotspots do not show their properties when hovered over. 

 

 

 

 

 

 

 

 

Fig. 10 Hotspot selection – Hand icon 

3.3.4 Control Modes 
Ockular has two control modes, [Select] and [Fire], that determine the visibility of user items and the operational 
behaviour of zones. 

 

Fig. 11 Control Mode buttons 

3.3.4.1 Select mode 

Control Mode [Select] is the default operating mode, but it will automatically change to [Fire] in the event of a priority 
alert.  

[Select] has the following behaviour: 

• HUDs are hidden 

• Zones are hidden 

• Hovering over an item displays a pop-out giving details of the item (where available) 

• Left click selects/deselects a zone or symbol 

• Ctrl-Clicking on a zone or symbol adds/removes it in the current selection 

3.3.4.2 Fire mode 

Clicking [Fire] has the following behaviour: 

• The Fire HUD is displayed. 

• Fire zones (of the default selected zone type) are shown. 

• Fire zones are shaded according to their published ‘Zone Status’ item. 

• Hovering the cursor over fire zones displays their status information in a pop-up. 

• Clicking selects/deselects the zone or symbol. 

• Ctrl-Click adds/removes the zone or symbol to/from the current selection. 

• Double clicking an item sends it to other linked Ockular GUIs. 

• Right click shows a context menu for the current selection. 
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Fig. 12 Zone coverage example 

Hover over for zone status information: 

 

 

 

 

 

 

 

 

Fig. 13 Zone status example 
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3.3.5 Fire Mode – Fire Activations 
Ockular automatically enters ‘Fire’ mode when any of the following fire event types happen: 

• Fire 

• Evacuation 

• Pre-Fire 

Ockular automatically shows the level for the first fire activation. The pop-up fire banner displays active fire 
activations. Scrolling through the list in the fire banner displays the relevant level for the activation. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Fig. 14 Fire mode with HUD (Head Up Display) 
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3.3.6 Split zones 
Zones in Ockular projects may span several levels, but each will have its own unique zone number. See the zone 
levels below for some zone naming examples. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Fig. 15 Example of zones spread across three levels 

Paging through the fire banner activations normally displays the level containing the primary zone. However, Ockular 
may have been configured to automatically ‘switch to device’, in which case it would display the level containing the 
triggering event. 
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4 Configuration and Status Menus 
This section contains important information about the configuration and status menus, which are controlled. The 
Configuration menu is on the left side of the Ockular screen: 

 

Fig. 16 Typical Operator Configuration Menu 

Note: You should only see the menus and sub-menus relevant to your authorized access level. If this is not the 
case you should log out the current user and log in as yourself. 

4.1 2D GUI 
The [2D GUI] button’s only function is to take you back to the Home screen. 

4.2 Alarm Config 
The [Alarm Config] button opens the Alarm configuration table, from where you can filter the displayed results, can 
create new alarms, copy existing alarms, or delete alarms: 

 

 

 

 

 

 

Fig. 17  Alarm Configuration Page 

4.3 Alarm Status 
Clicking the [Alarm Status] button gives you access to: 

• Alarm List 

• Alarm Event History 

• System Event Log 

• Additional Alarm Information 

• Suppressed Alarms Table 
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4.3.1 Alarm List 
The [Alarm Status] button opens a tabbed System Alarm Status page where you can filter the displayed results using 
the buttons, drop-down menus and column headers. 

 

 

 

 

 

 

 

 

 

Fig. 18 Alarm Status Page 

4.3.2 Alarm Event History 
The [Alarm Status] > [Alarm Event History] button opens a page where you can organize and filter the Alarm Event 
History using column sorting, drop-down menus and various filters. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Fig. 19 Alarm Event History Page 
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4.3.3 System Event Log 
The [Alarm Status] > [System Event Log] button opens a page where you can organize and filter the System Event 
Log using column sorting, drop-down menus and various filters. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Fig. 20 System Event Log Page 

4.3.4 Additional Alarm Information 
The [Alarm Status] > [Additional Alarm Information] button opens a page where you can organize and filter the 
Additional Alarm Information (if any) using column sorting, drop-down menus and various filters. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Fig. 21 Additional Alarm Information Page 
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4.3.5 Suppressed Alarms Table 
The [Alarm Status] > [Suppressed Alarms Table] button opens a page where you can organize and filter the 
Suppressed Alarms Table information (if any) using column sorting, drop-down menus and various filters. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Fig. 22 Suppressed Alarms Table Page 
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4.4 Fire 
Clicking the [Fire] button gives you access to: 

• Fire System 

• Maintenance 

• Event History 

• FAS Topology 

• Alarm List 

• Status Tree 

Note: The page defaults to the Alarm list on opening, and attempts to resync every 10 seconds. 

4.4.1 Fire System 
Selecting the [Fire System] button opens this page, from where you can select, acknowledge or print further report 
styles. You can also see a visual representation of the selected zone, with options to move or resize, and the ability 
to move up, down, left or right to see different evacuation zones. 

 

Fig. 23 Fire System 
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4.4.2 Maintenance 
Clicking the [Maintenance] button opens the following page: 

Note: Nodes and devices shown in this figure are by example. 

 

Fig. 24 Maintenance Home Page 

Selecting from the list of nodes populates the equipment list beneath. Upon selecting a device, the following options 
are available: 

• Enable selected device 

• Disable selected device 

Tip: Use click, [Shift+click] or [Ctrl-click] to select your panel first and then your equipment, or use the filter tools to 
find specific items in a long list. 

Selecting at least one item from the Equipment list enables the [Enable]/[Disable] buttons, which gives you the choice 
to disable / enable your selections. 

Upon initiating any of the above options, you will be prompted to enter a descriptive reason as to why the 
maintenance action has been undertaken. At least one character must be entered to proceed. 
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4.4.2.1 Active Events 

Click [Fire] > [Active Events] to open the tables of Active Events. From this page you can filter by specific event 
types, by Quick Filter, or by Advanced Filter (Boolean Search). 

 

Fig. 25 Active Events Page 
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4.4.3 Event History 
The Event History page shows all historic events with additional information (if available). The history can also be 
used to create reports, or it can be exported as a .csv file. 

The Event History can be very long and detailed, so authorized users can view and/or rearrange it by: 

• quick filter (e.g. Loop). 

• clicking column headings. 

• changing time/date periods. 

• choosing event type and sub-type. 

• using an [Advanced Filter] tool (i.e. drop-down menus for Columns + Operands + Data). 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Fig. 26 Event History Page 

 

 

 

 

 

 

 

 

Fig. 27 Event History – search categories 
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4.4.3.1  Advanced Filter Options 

In addition to the Column options shown below, users can apply the following operands and matching search 
parameters, where <n> equals a number and <x> is a string: 

 

 

 

 

 

 

 

 

 

 

Fig. 28 Advanced Filter Options Dialog 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

  

ADVANCED SEARCHES AND FILTERS 

Ockular reports allow both simple and advanced searches to narrow down a specific data type or series. 

Advanced filtering can use column headings with the following Boolean expressions plus free-text Data: 

• = equal to 

• != not equal to 

• > greater than 

• >= greater than or equal to 

• < less than 

• <= less than or equal to 

• Like... 

You can only currently create one filter term, so sometimes you may need to think about what to exclude 
rather than what to include… 

Example: [Zone = 2] would show only events that are listed for Zone 2, whereas [Zone != 2] would show all 
events except those in Zone 2. 
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4.4.4 Alarm List 
The [Alarm List] button opens a list of all the alarm events, with an itemized summary of alarm types at the bottom of 
the screen (circled). 

The list can be re-ordered alphanumerically by clicking the appropriate column header. 

 

Fig. 29 Alarm List Page 

4.4.5 Status Tree 
The [Status Tree] button opens an expandable tree layout of your Fire Alarm Control network and attached devices. 
You can use it to drill-down to see the current status and alert types of any listed item. 

Double click any item to expand or condense it, or use the [+] or [–] icons to expand or condense whole classes of 
items. 

Note: The values are controlled by the item type; some will return three values while others will return seven. 

 

Fig. 30 Status Tree Page
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Appendix A. Glossary 

Abb. Description 

2D Two Dimensional on the x-y axes 

3D Three Dimensional on the x-y-z axes 

ACID Access Control and Intruder Detection 

ANS Ambient Noise Sensor 

BGM Background Music 

BGU Break Glass Unit (fire alarm) 

BMS Building Management System 

CAE Cause and Effect 

CIS Customer Information Sensor 

CSV Comma Separated Values; the .csv file type allows files to be imported into columns and rows in 
spreadsheets and databases 

DDU Data Display Unit 

DIP Dynamic IP address (see SIP) 

EOL End Of Line (e.g. alarms, CCTV, detectors, sounders, speakers) 

EOLR End Of Line Resistor 

EOLD End of Line Diode 

FACS Fire Alarm Control System 

FAS Fire Alarm System 

GUI Graphical User Interface 

GUID Globally Unique Identifier used to identify equipment on a network 

HUD Head Up Display 

I/O Input / Output 

IP Internet Provider (networking) 

LAN Local Area Network 

LLPA Long Line Public Address 

NAC Notification Appliance Circuits 

Ockular Kentec’s control system platform and SDK 

OS Operating system (e.g. MS Windows, Android, Apple Mac, Linux, Unix etc.) 

PA Public Address 

PIDS Passenger Information Display System 

PiP Picture in Picture 

PIS Passenger Information System 

px Pixel (Picture Element – from Pics. Element.) 

PTT Press to Transmit 

qm .qm is a Qt Compiled Translation Source File 

RV Rendezvous point (Emergency vehicles) 
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Abb. Description 

SCADA Supervisory Control and Data Acquisition system 

SIP(1) Static IP address (see DIP) 

SIP(2) 

Session Initiation Protocol (SIP) is a communications protocol for signalling and controlling 
multimedia communication sessions in applications of Internet telephony for voice and video calls, 
in private IP telephone systems, as well as in instant messaging over Internet Protocol (IP) 
networks. 

SMS Station and building Management System / Site Management System 

SOP Site (or Standard) Operating Procedures 

TCP/IP Transmission Control Protocol/Internet Protocol 

TTS Text to Speech 

UAC User Account Control (Microsoft) 

UI User Interface 

UPS Uninterruptible Power Supply 

USB Universal Serial Bus 

UX User Experience 

VA Vital Area(1); Vulnerable Area(2); Visual Alarm/Alert(3); Voice Alarm(4) 

VDU Visual Display Unit; computer screen 

x – y 
axis 

x - y refers to screen pixel coordinates based on the available screen resolution (e.g. 1920 x 1080). 
X = the horizontal screen axis drawn left-to-right, and Y = the vertical screen axis drawn top-to-
bottom. A VDU’s nominal point of origin (x = 0, y = 0) is positioned at the top left of the screen, so a 
screen item’s nominal point of origin might be stipulated (in code) as [x = x+100; y = y + 100]. 

z axis z refers to a virtual axis running tangentially to the x-y axes; x-y-z coordinates can be used to 
create 3D objects that can pan, tilt, and rotate in virtual 3-dimensional space. 

z-index 
z-order 

Incident priorities are allocated to default layers arranged, in descending order, on the z-axis. In 
other words, the highest current priority (e.g. Fire) cannot be obscured by items of lower priority. 
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Appendix B. Ockular Keyboard Shortcuts 
These are the most useful keyboard shortcuts, but Windows key combinations may also work. 

Other key combinations are available in Editor mode. See the Ockular 2D GUI Editor User Guide Appendix B for 
more information. 

All Modes 
Alt-F Opens the File menu 
Alt-F, X Opens the Exit dialog 
Alt-[F4] Closes the active window 
Alt-H Opens the Help menu 
Alt-H, A Opens the ‘About Ockular’ pop-out 
Alt-H, Q Opens the Quick Guide in Foxit Reader 
Alt-H, U Opens the User Manual in Foxit Reader 
Alt-V Opens the View menu 
Alt-V, S Save Settings 
Alt-Tab Tab through open workspaces (useful when Ockular is in front of other open windows) 
[Del] Delete selected items 
[Esc] Closes the currently open dialog 
[F3] Opens the Search window 
[F5] Show/Hide Main GUI 
Windows + L Lock your screen (saves you from logging out or closing Ockular) 
Windows + M Minimise all windows (useful if you want an empty desktop, especially in Windows 10) 
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Appendix C. Frequently Asked Questions 

FAQ Question Answer Remedy 

1 Why won’t Ockular start? No dongle, or dongle out of 
date. 

Fit a current dongle before 
launching Ockular 

3 
Why does my screen appear 
wrong? New installation Administrator either load a project 

or create and save a new one. 

4 
Why does my screen appear 
wrong? 

Changes were made and saved 
by the last user 

Administrator load a previously 
saved version and then save it. 

5 
Why does my screen appear 
wrong? Is split screen selected? Administrator change to full 

screen settings 

9 
Why did Ockular close 
unexpectedly? 

You may have closed the 
Bootstrap CMD window by 
mistake, and you will have lost 
any unsaved changes. 

Administrator restart Ockular and 
begin afresh. Save regularly 
during edits. Save versions if 
making a lot of changes. 

 

 



 

 

End of Document. 
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